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Overview
Tanium Comply™ (Comply) allows users to support their enterprise compliance goals at
Tanium speed. Comply is primarily used for operating system-level checks and scales
using the Tanium architecture. It features the following benefits:
l

l
l
l

Evaluates benchmarks and vulnerabilities against operating systems, network
configuration, password policy, file permissions, and other components
Supports Windows, Linux, and macOS platforms
Supports Center for Internet Security (CIS) content
Enables custom checks and result mapping

Comply terminology
The following are definitions of terms used in Comply:
Security Content Automation Protocol (SCAP)
Comply uses SCAP content to perform compliance checks. These specifications
are derived from the input of a community of industry professionals working to
advance automation and standardization of technical security operations.
Extensible Configuration Checklist Description Format (XCCDF)
Collection of security configuration rules (primarily composed of OVAL checks)
applied against endpoints. XCCDF does not include commands to perform the
scan; it is mostly descriptive. Rule evaluation is defined in OVAL. XCCDF files are
sometimes called benchmarks or checklists.
Open Vulnerability and Assessment Language (OVAL)
A declarative language that defines how a rule is evaluated. OVAL makes logical
assertions about the state of a system and is used to describe security
vulnerabilities or desired configuration of systems.
Common Vulnerabilities and Exposures (CVE)
A public database of known vulnerabilities.
Vulnerability source
A path to a local Open Vulnerability and Assessment Language (OVAL) definitions
file or a URL to a remote OVAL definitions file.
Custom check
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An arbitrary powershell, VBScript, or UNIX shell script used to evaluate conditions
on an endpoint.
Custom ID mapping
Maps custom check ID or XCCDF rule ID to arbitrary value. Helpful in mapping
CIS content to some other policy or associating arbitrary tags with rules.
Report
A package containing a zip file of all XCCDF benchmarks, custom check scripts,
custom profile definitions, and optional custom ID mapping definition. A report
includes the action to distribute to selected computer groups as well as the saved
question to retrieve scan results from endpoints.

Scheduling actions in Comply
When the scheduling option is available in Comply functions, such as when you create
reports, the following fields are available:
Field

Value

Start at
End at

When Recurring is selected for Schedule, complete these
fields to limit the report to run only during a specific time
period.

Distribute
over

Select and enter values to run the report over minutes, hours,
or days.

Reissue
every

Select and define the interval in minutes, hours, or days in
which the report will run.
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Getting started
1. Install Comply. For more information, see Installing Comply on page 11.
2. Import scan engines. For more information see Importing scan engines on page
15.
3. Create computer groups. For more information, see Creating computer groups on
page 19.
4. Create deployments. For more information, see Creating deployments on page 20.
5. Work with benchmarks. For more information, see Working with benchmarks on
page 25.
6. Create reports. For more information, see Creating reports on page 36.
7. View, edit, or delete reports. For more information, see Working with reports on
page 42.
8. Deploy custom checks and use custom ID mapping. For more information, see
Deploying custom checks and using custom ID mapping on page 51.
9. Create custom profiles. For more information, see Creating custom profiles on
page 56.
10. Remove Comply content and tools from endpoints. For more information, see
Deleting Comply content from endpoints on page 67.
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Requirements
Licensing
Comply is licensed for installation as a component of the Tanium Server. To obtain a
license, see your Tanium Technical Account Manager (TAM).

System requirements
l
l
l
l
l
l

Microsoft Windows 7 or later
Microsoft Windows Server 2008 or later
Red Hat Enterprise Linux and CentOS 5 through 7
Debian 7 and 8
Ubuntu 12.04 and 14.04
Apple Mac OS X 10.11

Installation prerequisites
Before installing Comply, you need to have a service account with Tanium Administrator
credentials. You must also have the Tanium Module server running.
You must be a member of Center for Internet Security (CIS) in order to download the
tools you need to use Comply to run CIS scans.
You must be a part of the United States government to use the Security Content
Automation Protocol (SCAP) Compliance Checker (SCC) scan engine. If you are part of
a government organization, consult with your TAM on how to obtain the appropriate
SCC bundles.
Endpoints to be scanned either need to have Java already installed or be provided with
a Java Runtime Environment (JRE) via Comply. The JRE can be downloaded from
www.oracle.com/technetwork/java/javase/downloads/index.

User roles
The following user roles are supported in Comply:
Question Author
Can view reports, drill down into reports, and create report exports.
Content Administrator
Has all privileges in Comply with the exception of installing or uninstalling Comply.
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Administrator
Has all privileges in Comply, including installing or uninstalling Comply.

Center for Internet Security benchmarks and tools
Tanium Comply assesses endpoints using Center for Internet Security (CIS)
benchmarks and the Center for Internet Security Configuration Assessment (CIS-CAT)
tool, both of which are available to members of CIS. You will need to download the
benchmark bundle from CIS before getting started with Tanium Comply.
Note: Comply does not currently support any checks that require authentication
such as database server scans and does not provide its own compliance scanning
engine.
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Installing Comply
Before installing Comply, refer to Requirements on page 9. The installation of Comply is
done from the Tanium Console.

Import solution
1. Log into the Tanium Console using an account with Administrator privileges.
2. Select Tanium Solutions from the main menu.

3. Click Import X.X.X.X (where X.X.X.X is the current module version number) under
Comply.
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Note: Tanium Comply is a Tanium licensed solution. Contact your TAM to
obtain a license if you do not have one.
4. If you are prompted, click Proceed with Import. Enter your credentials. This begins
the Tanium Comply installation and configuration process.
After the Tanium Comply installation and configuration process completes, you see the
message Import completed successfully, and Comply appears in the main menu.

Upgrade Comply
When there is a new version of Comply available, you will be prompted to Upgrade to
X.X.X.X (where X.X.X.X is the new module version number) under Comply on the
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Tanium Solutions page. The upgrade steps are the same as the import steps.

IMPORTANT: When you upgrade Comply, a red error message will be displayed
if a deployment's tools are out of date. To deploy the latest tools to deployments
with this error, click Redeploy. This will upgrade the tools on endpoints to the
latest version the next time the tools installation Action runs.

Set up Comply
1. From the main menu, select Comply. The Home page shows setup status. If no
reports and deployments are configured, you will be prompted to go to the Setup
page. Otherwise, you will see the four most recent reports and the three most
recent deployments.
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2. Select Setup under the Home menu. The Setup page summarizes the steps
required to get started with Comply.

Note: Comply does not ship with its own scan engine, so you must upload a scan
engine before using Comply. Scan engines are used to evaluate OVAL or SCAP
content and generate configuration compliance and vulnerability reports. At least
one scan engine is required to use Comply, but more than one can be uploaded
and used if desired. See Importing scan engines on page 15.

© 2017 Tanium Inc. All Rights Reserved

Page 14

Importing scan engines
Comply does not ship with its own scan engine, so you must upload a scan engine
before using Comply. Scan engines are used to evaluate OVAL or SCAP content and
generate configuration compliance and vulnerability reports. At least one scan engine is
required to use Comply, but more than one can be uploaded and used if desired.

Download and import the CIS engine
1. Go to https://community.cisecurity.org and log in or click Register if this is the first
time you are using CIS Security benchmarks.
2. Go to the CIS-CAT Downloads page to download the latest ciscat-full-bundle.zip
file. You can also get to this page once you are logged in by clicking Downloads in
the top menu and clicking Tools: CIS-CAT in the right margin.
3. In Comply, select Engines under the Setup menu.
4. On the Manage Engines page, click Upload Engine/JRE on the top right.
5. In the Engine Type drop-down, select CIS-CAT.

6. Click Select File to select the zip file you downloaded from CIS.
7. Check Import Benchmarks to import the benchmarks in the bundle into Comply.
Tanium recommends that you check this option. This option will be enabled by
default the first time you upload the CIS-CAT bundle.
8. Uncheck Import Engine if you have already imported the required engine and you
only want to import benchmarks (see note below).
9. Click Upload.
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Note: In order to upgrade your benchmarks when CIS releases a new version of
the bundle, select Import Benchmarks only. This is how new, updated
benchmarks are imported into Comply in bulk. Existing reports and benchmarks
will be not affected by this process, and the benchmarks used in these reports are
not automatically upgraded to the new versions of the respective benchmarks.

Import the SCC scan engine
SCC is the scan engine used by the United States government; it is not available to the
general public. If you are part of a government organization, consult with your TAM on
how to obtain the appropriate SCC bundles.
Note: Within each SCC zip file, there is another zip (on Windows) or a tar.gz file
(on Linux/OS X). Comply will accept these inner zip or tar.gz files as well as the
original zip archive. This reduces the amount of data in half that you must upload.
1. Select Engines under the Setup menu.
2. On the Manage Engines page, click Upload Engine/JRE on the top right.
3. In the Engine Type drop-down, select SCC.

4. Click Select File to select the the SCC bundle that you would like to upload.
5. Click Upload.
Note: Some SCC bundles come packaged with DISA STIG benchmarks. To
import these, be sure to check Import Benchmarks. Not all SCC bundles include
this content.
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Download and import the Java Runtime Environment (JRE) package
Go http://www.oracle.com/technetwork/java/javase/downloads/index and download the
appropriate Java Runtime Environment (JRE) package for each platform and
architecture required for the endpoints in your environment. The standard JRE and
server JRE are supported. JDK packages are not supported. Be sure to download the
tar.gz packages, not the exe, rpm, or dmg files.
Note: If you already have the appropriate JRE package(s) installed, you may not
need to download additional JRE packages. Tanium recommends using Comply
to install a JRE and not using a pre-installed JRE so that you know which JRE is
being used to run scans.
1. Select Engines under the Setup menu.
2. On the Manage Engines page, click Upload Engine/JRE on the top right.

3. In the Engine Type drop-down, select Java runtime.
4. Click Select File to select one of the JRE tar.gz files that you downloaded
earlier.
5. Click Upload.
Note: You can remove engines and JREs from the Manage Engines page by
clicking Remove.
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Download and import Joval
Note: In order to use Joval, you must have a license and the Joval engine zip file
downloaded.
1. Select Engines under the Setup menu.
2. On the Manage Engines page, click Upload Engine/JRE on the top right.
3. In the Engine Type drop-down, select JovalCM.

4. Click Select File to select the Joval engine file.
5. Click Upload.
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Creating computer groups
Comply will automatically target platform and architecture; however, if you need to run
benchmarks or push deployments against endpoints with a specific operating system or
on a specific subnet, you need to create computer groups. Define computer groups in the
Administration section of Tanium™ Console. See Tanium Platform User Guide:
Managing Computer Groups.

Examples of computer groups
Following are examples of computer groups for operating systems created by selecting
the appropriate query suggested by Tanium's language parser:
Operating System

Query

Windows

Operating System containing “Windows Server 2012 R2”

Linux

Operating System containing “CentOS release 6.3 (Final)”

OS X

Operating System containing “Mac OS X (10.11.6)”
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Creating deployments
1. Select Deployments under Setup.
2. On the Setup Deployments page, click Create Deployment on the top right.

3. Provide a Description.
4. Select a Platform and Architecture.
5. Select or deselect Engines you have imported. You are able to select multiple
engines in this field.
6. Select Computer Groups you want to target with the deployment. You are able to
select multiple computer groups in this field.
7. Refer to Scheduling actions in Comply on page 7 for an explanation of the Start at,
End at, Distribute over, and Reissue every fields.
8. Click Create & Deploy. You will see the Action progress and Installation status of
your deployment.

© 2017 Tanium Inc. All Rights Reserved

Page 20

Using JRE encryption
Use JRE encryption to prevent access to the JRE. This will encrypt the zip file on the
endpoint that contains the JRE, and a key file is distributed with reports that require the
JRE to decrypt it. Once the report runs, the key file and decrypted JRE are removed. The
encrypted JRE remains so it can be used the next time it is required.
1. Complete all of the fields in the Create Deployment window and select a JRE in
the Engines field.
2. Select Encrypt JRE.
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3. Click Create & Deploy. On the Reports page, any report with an encrypted JRE
will show a lock next to that engine.
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Working with deployments
To redeploy, delete, or see the status of a deployment, select Deployments from the
Setup menu.
When you redeploy a deployment, you can view the Action progress and Installation
status.
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Click information
deployment.

next to Target to see the target computer groups for that

Legacy deployments
On the Setup Deployments page, click Remove to delete Legacy Deployments that are
obsolete. Removing legacy deployments will stop/remove the old action and package
associated with these deployments. You may need to create a new deployment that
matches the legacy deployment to ensure that engine/JRE selections are deployed as
previously.
Note: Tanium recommends that you remove legacy deployments.
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Working with benchmarks
Note: Before you can work with benchmarks, you must import them. See
Download and import the CIS engine on page 15 and Import the SCC scan engine
on page 16 for instructions on how to import or upgrade benchmarks in bulk.
After importing engine files, you can view imported benchmarks to verify that they have
been imported. Select Configuration Compliance or Vulnerability under Benchmarks to
view each type of imported benchmark.

Configuration compliance benchmarks
Importing individual benchmarks and assigning categories
1. On the Configuration Compliance page under Benchmarks, click Import
Benchmark to import additional configuration compliance benchmarks.

2. Provide a Description for the benchmark.
3. Assign an existing category to the benchmark or create a new category to help
organize your benchmarks. Select a category from the Category drop-down list or
select Create new category... to create a new category to assign to the
benchmark.
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4. Enter any custom tags in the Tags field to further describe and categorize the
benchmark.
Note: When Benchmarks are imported with an engine, such as CIS-CAT or
SCC, they are automatically assigned the applicable category. By default,
new Benchmarks are assigned the Imported Category.
5. If you've chosen to create a new category, in the Create Category window, enter a
name for your new category and click Save.

You can also view all categories and create a new category from the Tools menu.
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1. Click tools

on the far right of your screen.

2. From the Tools menu, select Manage Benchmark Categories.

3. On the Benchmarks Categories page, click New Benchmark Category.
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4. In the New Benchmark Category window, enter a name for your new category and
click Save.

FILTER BENCHMARK CATEGORIES

You can filter benchmarks by category on the Configuration Compliance Benchmarks
page under Benchmarks by selecting a category in the Category drop-down list.

DELETE BENCHMARK CATEGORIES

1. From the Tools menu, select Manage Benchmark Categories.
2. On the Benchmark Categories page, select a category and click delete
to
delete a category. You can only delete a category that contains no benchmarks.
CHANGE A BENCHMARK CATEGORY OR TAGS

1. On the Configuration Compliance Benchmarks page, hover over a venchmark
and you will see the Change Category/Tags button.
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2. In the Benchmark Metadata window, select a different Category and edit Tags.

3. Click OK.

Filtering benchmarks
Use the Tag Filter field at the top right of the Configuration Compliance Benchmarks
page to filter the benchmarks. Begin entering text to see a list of available tags or click
the X next to an existing tag to remove it from the list of filters.
The green supported tag indicates that Tanium has tested the benchmark. Only
supported Benchmarks are shown by default. Benchmarks indicated with a yellow
unsupported tag are benchmarks that Tanium has not tested. This does not mean that
the benchmark does not work; it has just not been tested by Tanium.

Viewing configuration compliance benchmark profiles and creating reports
1. Click expand

to see the details of a configuration compliance benchmark.

2. Under the Profiles section, click Create Report next to a benchmark profile to
create a report for that profile. Clicking Create Report at the top right creates a
report for the first profile listed. The Name, Platform, Benchmark, and Profile fields
are auto-populated based on the benchmark and profile you selected. These
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values can be changed.

3. On the New Configuration Compliance Report page, enter a Name for the report
in the Details section. You can also provide a Description.

4. Select a Platform.
5. Select the Engine. You will only see the Engine field if you have more than one
engine installed.
6. The Tanium Comply action group is created automatically by Comply and will be
auto-populated in the Action Group field. All saved actions created by Comply will
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be created under this action group.
7. Select Computer Groups.
IMPORTANT: Be sure to select the appropriate platform (Windows, Linux, or
OS X) and Computer Groups containing endpoints that align with the
Platform for Comply to work correctly.
8. Select either Low or Normal from the Execution Priority drop-down list. This will
determine if other processes running on an endpoint take priority over running the
report you are creating or if the report takes the same priority as other processes.
9. Refer to Scheduling actions in Comply on page 7 for explanations of the Start at,
End at, and Distribute over fields.
10. Select None, Interval, or Report Result Age for the Repeat report execution by
field.
11. If you choose Interval, the Reissue every field will appear, and you must specify
how often the report is run.
12. If you choose Repeat Result Age, then the Run when results are older than field
will appear, and you must specify how old you want the results to be before the
report is run. If an endpoint comes online that has never run a report, it will run with
this option selected. The age of results is checked either every hour or every 3
hours. If you specify an age less than 3 hours, the age of results will be checked
every hour.
13. Select the Benchmark and Profile from the drop-down lists in the Benchmarks
section.
14. Click + Add Additional Benchmark to add another benchmark or click Create &
Deploy and enter your credentials. Action results will display.
15. If you have Custom Checks or Custom ID Mappings, you can specify these in the
Advanced section. See Deploying custom checks and using custom ID mapping
on page 51 for more information.

Vulnerability benchmarks
Default vulnerability benchmarks
By default, Comply provides three vulnerability sources:
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l
l
l

Tanium Vulnerability Library for Unix
Tanium Vulnerability Library for macOS
Tanium Vulnerability Library for Windows

Expand default vulnerability benchmarks to view details, create a report, update them, or
edit them. Click on the number of CVEs to see the full list of CVEs included in a
benchmark.
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Tanium maintains these default vulnerability sources and makes updates to them daily
as they become available. To schedule automatic updates to these vulnerability
sources, check Enable recurring updates on the Edit Vulnerability Source page.
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Note: Enabling recurring updates only updates definitions associated with the
source. If you have already created reports against the source, these reports do not
get automatically updated. To create a report with update definitions, you must
delete the previous report and create a new one once the source is updated.

Create a new vulnerability source
1. Click Create Source on the top right of the Vulnerability Benchmarks page.

2. In the Details section, provide a Name, Vendor, and Description.
3. To schedule automatic updates, check Enable recurring updates.
4. In the OVAL Definitions File section, choose either Remote or Upload for the
Location.
Note:
A remote source is a URL that points to an OVAL definition XML file and can
be updated by simply clicking Update next to the benchmark on the
Vulnerability Benchmarks page.
Remote sources are best suited when OVAL content is updated periodically.
Uploaded sources are best suited to air gapped environments or when you
would like to manually download and provide the source feed.
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This OVAL definition file from CIS provides access to all vulnerability
definitions in their repository:
https://oval.cisecurity.org/repository/download/5.11.1/all/oval.xml
5. Enter the path for the Remote File or Choose file for Upload as appropriate.
6. Click Save.

Edit a vulnerability source
On the Vulnerability Benchmarks page, you can also select edit
source or delete

to edit a vulnerability

to delete a vulnerability source.

Perform a vulnerability scan and create a report
1. Click expand to see the details of a vulnerability benchmark to view information
about the associated XML file and operating systems. Click Create Report at the
top right to create a new vulnerability report.
2. See Create a vulnerability report on page 39 for more details.
3. Click Create & Deploy to run the vulnerability scan.
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Creating reports
Note: Comply works best with operating system-level checks. See Creating
computer groups on page 19.
You can create a new report on the Reports page or create one using an existing
benchmark on the Benchmarks page.
Run a configuration compliance report to check the security configuration compliance
state of a group of machines. This will execute reports using SCAP XCCDF
benchmarks. Run a vulnerability report to execute OVAL checks against your endpoints
to check for the presence of identified vulnerabilities.

Create a configuration compliance report
Create a configuration compliance report from the Reports page
1. Select Reports from the main menu.

2. Select Configuration Compliance Report from the Create Report drop-down list.
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3. On the New Configuration Compliance Report page, enter a Name for the report
in the Details section. You can also provide a Description.

4. Select a Platform.
5. Select the Engine. You will only see the Engine field if you have more than one
engine installed.
6. The Tanium Comply action group is created automatically by Comply and will be
auto-populated in the Action Group field. All saved actions created by Comply will
be created under this action group.
7. Select Computer Groups.
IMPORTANT: Be sure to select the appropriate platform (Windows, Linux, or
OS X) and Computer Groups containing endpoints that align with the
Platform for Comply to work correctly.
8. Select either Low or Normal from the Execution Priority drop-down list. Low
causes the Comply scan process to yield processor utilization to other processes
running on the machine. Normal will execute the scan process with the same
priority as other processes running on the machine.
Note: Selecting Low may increase the duration of the scan processes on
endpoints with high processor utilization.
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9. Refer to Scheduling actions in Comply on page 7 for explanations of the Start at,
End at, and Distribute over fields.
10. Select None, Interval, or Report Result Age for the Repeat report execution by
field.
11. If you choose Interval, the Reissue every field will appear, and you must specify
how often the report is run.
12. If you choose Repeat Result Age, then the Run when results are older than field
will appear, and you must specify how old you want the results to be before the
report is run. If a targeted endpoint comes online that has never run the report, the
report will be run as soon as the next age-check occurs. The age of results is
checked either every hour or every 3 hours. If you specify an age less than 3 hours,
the age of results will be checked every hour.
13. Select the Benchmark and Profile from the drop-down lists in the Benchmarks
section.
14. Click + Add Additional Benchmark to add another benchmark or click Create &
Deploy and enter your credentials. Action results will display.
15. If you have Custom Checks or Custom ID Mappings, you can specify these in the
Advanced section. See Deploying custom checks and using custom ID mapping
on page 51 for more information.

Create a configuration compliance report from the Benchmarks page
1. On the Benchmarks page, click expand
compliance benchmark.

to see the details of a configuration

2. Under the Profiles section, click Create Report next to a benchmark profile to
create a report for that profile. Clicking Create Report at the top right creates a
report for the first profile listed.
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Create a vulnerability report
Create a vulnerability report from the Reports page
1. Select Reports from the main menu.

2. Select Vulnerability Report from the Create Report drop-down list.

3. On the New Vulnerability Report page, enter a Name for the report in the Details
section. You can also provide a Description.
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4. Select a Platform.
5. Select the Engine. You will only see the Engine field if you have more than one
engine installed.
6. The Tanium Comply action group is created automatically by Comply and will be
auto-populated in the Action Group field. All saved actions created by Comply will
be created under this action group.
7. Select Computer Groups.
IMPORTANT: Be sure to select the appropriate platform (Windows, Linux, or
OS X) and Computer Groups containing endpoints that align with the
Platform for Comply to work correctly.
8. Select either Low or Normal from the Execution Priority drop-down list. Low
causes the Comply scan process to yield processor utilization to other processes
running on the machine. Normal will execute the scan process with the same
priority as other processes running on the machine.
Note: Selecting Low may increase the duration of the scan processes on
endpoints with high processor utilization.
9. Refer to Scheduling actions in Comply on page 7 for explanations of the Start at,
End at, and Distribute over fields.
10. Select None, Interval, or Report Result Age for the Repeat report execution by
field.
11. If you choose Interval, the Reissue every field will appear, and you must specify
how often the report is run.
12. If you choose Repeat Result Age, then the Run when results are older than field
will appear, and you must specify how old you want the results to be before the
report is run. If a targeted endpoint comes online that has never run the report, the
report will be run as soon as the next age-check occurs. The age of results is
checked either every hour or every 3 hours. If you specify an age less than 3 hours,
the age of results will be checked every hour.
13. Select the Source and Operating System from the drop-down lists in
the Vulnerability Source section.
14. Specify the CVE Years. The Preview section on the right will show the number of
CVEs and Definitions that will be included in the report.
15. Check the scores you want to see in CVSS Scores.
16. List specific CVEs.
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Note: Specified CVEs will always be included in the report regardless of the
values specified for CVE Years or CVSS Scores. To search by year and
score, you must provide values for both fields for the search to be valid. If you
specify CVE Years, you must select at least one score in CVSS Scores. If
you select a score in CVSS Scores, you must specify CVE Years. If you list
specific CVEs, you can choose to leave the CVE Years field blank and
select no CVSS Scores.
17. Specify the Batch Size.
Note: Batch Size defines the number of checks that will run at a time. The
default value for this field is 500 in order to run a manageable number of
checks on your endpoints. Consult with your TAM if you want to adjust this
value.
18. Click Create & Deploy and enter your credentials. Action results will display.

Create a vulnerability report from the Benchmarks page
1. Select Benchmarks from the main menu and click expand next to the
vulnerability benchmark for which you want to create a report.
2. Under the Profiles section, click Create Report next to the benchmark profile for
which you want to create a report.
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Working with reports
View results
Select Reports from the main menu to view the results for All reports, Configuration
Compliance reports, or Vulnerability reports that have been run and if/when they are
scheduled to run again.
Click Go to Interact
next to Endpoints Analyzed to go to Interact to view any
endpoints reported on that are currently online.

Click information

next to Target to see the target computer groups for that report.

Click on a report to see details and results associated with that report and details about
the policies included in configuration compliance reports and questions included in
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vulnerability reports.

Click on a rule to see a detailed description of that rule.
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When a report is loading, it may take some time to display results as they are retrieved
from the Tanium server. To see results immediately as they load, click Refresh Results.

View scheduled report actions
You can view reports that are scheduled to run on the Tanium Comply action group in
the Tanium Console.
1. Select Scheduled Actions under Actions from the main menu.
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2. On the Actions page, enter Comply in the search field and select Tanium Comply to
see the Reports scheduled to run on the Tanium Comply Action Group.

Selecting the Tanium Comply Action Group shows all scheduled actions for Comply,
including engine/JRE scheduled actions as well as those created for report execution.

Run a report again
1. Select Reports from the main menu and click on the report you want to run.
2. Click Deploy Now to run that report again.

Export report results
1. On the Reports page for All, Configuration Compliance, or Vulnerability, select a
report.
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2. Under the Report Options drop-down list at the top right, click Export Results.

3. In the Export Report window, provide a Title and Description for the report.

4. Choose either HTML or CSV from the Format drop-down list for the exported data.
5. By default, pass, fail, and error report types are already selected. Click in the
Report Types field to select additional types or to remove any of the default types.
6. Select options for Results Display and Rule Details. Results Display can be used
to turn off the summary values for each result so that the endpoint list will the
complete list of computer names and IP addresses.
7. Click Export. Enter your credentials and click OK.
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Note:You can close the Export Report window and let the report export
process run in the background. Go to the Report Export page to view the
progress of any report export jobs currently running. The last column in the
results table on indicates the status of the report export job..
8. When the export report is complete, click View report export to go to the Report
Exports page or click Download to download the report in the format you selected.
9. On the Report Exports page, select a report and click download

to download it.

Edit report schedules
1. Select Reports from the main menu.
2. Hover over a Report name and click date picker
to change the schedule for that
Report.
3. Refer to Scheduling actions in Comply on page 7 for an explanation of the fields
available in the Edit window.

4. Click Save.

Delete a report
Note: You cannot edit the content of a Report once it has been created, and you
cannot delete a Benchmark, Custom Check, or Custom ID Mapping if they are
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associated with a Report. You can only change when a Report runs per Edit report
schedules on page 47.
When an updated version of a new Benchmark is released, you must delete the Report
that used the old Benchmark and create a new report with the updated Benchmark.
1. Select Reports from the main menu and hover over a Report name.
2. Click delete

to delete that Report from your list of Reports.

3. See Deleting stale reports from endpoints on page 48 to remove the Report from
the endpoints.

Deleting stale reports from endpoints
If you have deleted a Report using the procedure described in Delete a report on page
47, you still need to delete it from the endpoint(s).
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1. Click tools

on the far right of your screen.

2. Select Manage Stale Reports from the Tools menu.

3. The Stale Reports window will appear and provide a list of Reports that are no
longer known to comply. Select the Report you would like to remove. Refer to
Scheduling actions in Comply on page 7 for an explanation of the scheduling
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fields available in the Stale Reports window.

4. Click Remove Selected.
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Deploying custom checks and using
custom ID mapping
Custom checks
You can create custom checks in Comply to check a condition on endpoints that may not
be included in any benchmark. A custom check can be either PowerShell or VBScript on
Windows and bash shell scripts on Linux/OS X. PowerShell scripts should use the file
extension .ps1, and VBScript files should use the .vbs extension.
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1. Click tools

on the far right of your screen.

2. Select Manage Custom Checks from the Tools menu.

3. On the Custom Checks page, click New Custom Check.
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4. Complete the Title, Description, Identifier (can be used to trace back to
corresponding custom ID mapping), and the optional Severity fields in the New
Custom Check window.
5. Select the appropriate Platform (Windows or Linux).
6. Click Select File and locate the file for the custom check.

7. Click Save. Your custom check will now appear on the Custom Checks page and
in the Advanced section of the New Report page when you create a new report.

Note: Custom checks should take less than a minute to run – they can output
anything to standard output as long as the last line is a valid rule result string such
as pass, fail, or error.

Custom ID mappings
Custom ID mappings allow you to create a custom column on results that associates a
specific tag with a custom check or rule identifier.
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1. Click tools

on the far right of your screen.

2. Select Manage Custom ID Mappings from the Tools menu.

3. Click New Custom ID on the Custom IDs page.

4. Enter a Name and Description in the New Custom ID window.
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5. Click Select File and locate the custom ID mapping file.

6. Click Save. Your custom ID will now appear on the Custom IDs page and in the
Advanced section of the New Report page when you create a new report.

Following is the file format used for a custom ID mapping: Rule id | custom id
Example: xccdf_org.cisecurity.benchmarks_rule_1.1.1_Create_
Separate_Partition_for_tmp|company_policy_rule_42
Note: A report can only have a single custom ID mapping associated with it;
however, it can have multiple benchmarks and custom checks. When selecting the
benchmarks and custom checks, be aware that a report is targeted to a single
action group.
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Creating custom profiles
A profile defines a set of rules to be evaluated and the parameters for those rules.
Custom profiles allow you to specify just a subset of the checks available in a
benchmark to be deployed.
To create a custom profile
1. Click tools

on the far right of your screen.

2. From the Tools menu, select Manage Custom Profiles.
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3. On the Custom Profiles page, click New Custom Profile.

Note: A custom profile can also be specified with a tailoring file. For more
information about tailoring files, see NSIT's Technical Specification for the
Security Content Automation Protocol (SCAP) or consult with your TAM.
4. On the New Custom Profile page, enter a Title.

5. Enter an ID that matches the following regular expression: xccdf_[^_]+_
profile_.+.
Example: xccdf_customprofile_profile_1
6. Enter a Description.
7. In the Rules section, select a benchmark from the Benchmark drop-down list.
8. Select each rule you would like to include in your custom profile.
9. Click Add Selection to Profile to move the selected rules to the Selected Rules
section. You can click Remove Selection From Profile to remove any rules you
have added.
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10. Click Create to create the new custom profile.

You can also modify some rule values within your custom profile. If a rule value is
customizable, a value of true will appear in the Can Customize column along with the
default value for the rule in the Default Value column.
To customize a rule value
1. Select the rule and click Modify Rule Value.
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2. In the Modify Custom Profile Value window, enter a Custom Rule Title and
change the Custom value field.

Note: Rule titles occasionally include the value used in the rule. Customize
the title of rules for which values have been changed. The customized rule
titles will then show up in report results, question answers, and report
exports. For example, If you provide a new value for the rule (L1) Ensure
'Enforce password history' is set to '24 or more password(s)', you can
change 24 to match the custom value.
3. Click Save. The new value will appear in the User-defined Value column. You can
return to the Default Value of a rule by clicking Use Default.
On the Custom Profiles page, select a custom profile and click Show Details to view
Custom Profile Details.
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You will see the rules included in the custom profile as well as those for which the
values have been modified.
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Managing Comply settings
Consult with your TAM before changing any Comply settings to better understand
implications of changing setting values.
To manage Comply settings
1. Click tools

on the far right of your screen.

2. Select Manage Settings from the Tools menu.

3. To edit a setting, click the setting and then click Edit.
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4. Enter a Value and click Save.

Note: Comply settings are configured by Tanium and set to default values. Users
cannot create settings. If you click delete
, you will only delete any manually
entered Value, not the setting. The setting value will return to the default value.
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Troubleshooting
Do not manually delete any Tanium content that includes “Comply” in the name for any
reason. This can cause Comply to stop working correctly.

Collect logs
You may need to collect logs associated with Comply for troubleshooting purposes
when working with technical support or your TAM.
To collect logs
1. Click information

on top left of the screen.

2. Click Collect to download logs. And then click Download to obtain a support
bundle of files to provide to your TAM or technical support.

Locate log files
You may need to locate log files on your endpoint or on the Tanium Module Server for
troubleshooting purposes when working with technical support or your TAM.
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Endpoint log files
Comply log files are created on endpoints at the following path: C:\Program Files
(x86)\Tanium\Tanium Client\Tools\Comply\logs
Log files for each scan are keyed by report hash. Only the most recent file is kept.

Tanium Module Server log files
Comply log files are created on the Tanium Module Server at the following path:
C:\Program Files\Tanium\Tanium Module Server\services\complyservice\logs
Service log files are found here.

Recreate JRE encryption key
If a JRE encryption key is lost or overwritten, Comply allows you to recreate the JRE
encryption key.
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1. Click tools

on the far right of your screen.

2. From the Tools menu, select Manage JRE Encryption Key.

3. In the Change JRE Encryption Key window, click Rekey to generate a new JRE
encryption key.
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Note: You can provide your own encryption key; however, Tanium
recommends that you do not enter anything in the Leave blank to have your
new key generated by Tanium field.
4. Enter your credentials and click OK.
IMPORTANT: If you have existing reports on endpoints with an encrypted
JRE, those reports must be redeployed. In addition, all existing encrypted
deployments must be redeployed so they are updated with the new key.
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Deleting Comply content from endpoints
If you decide to uninstall Comply or want to remove Comply content and tools from an
endpoint, use the Comply Remove Client Files actions. There is one for Windows and
one for Unix (Linux/OS X).
To remove Comply content and tools
1. Select Interact from the main menu.

2. Enter a query to target the endpoints from which you want to remove Comply
content and tools. For example, enter Get online from all machines if you want to target
all endpoints that are online. Select the appropriate query suggested by Tanium’s
natural language parser.
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3. Check True and then click Deploy Action.

4. On the Deploy Action page, enter Comply in the Enter package name here field.
5. Select either the Comply - Remove Client Files - Windows or Comply - Remove
Client Files - Unix action, as appropriate, to the the endpoints where you wish to
remove Comply content and tools. Refer to Tanium Platform User Guide:
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Managing Scheduled Actions for more information.
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6. Check Remove ALL Comply files if you want to remove all Comply content and
tools or check just the content and tools you want to remove.

7. Click Show preview to continue at the bottom of the Deploy Action page.
8. A results grid will appear at the bottom of the page showing you the targeted
endpoints for your action. If you are satisfied with the results, click Deploy Action.
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